
Lindorm Inc. LINDORM.COM 

SOFTWARE MANUAL 4.0.DOCX 2018-01-06 PAGE 1 OF 31 

SediMeter™ 

Software 

Manual 

version 4.0 

  



Lindorm Inc. LINDORM.COM 

SOFTWARE MANUAL 4.0.DOCX 2018-01-06 PAGE 2 OF 31 

Formalities 

Document Scope 

This is a user manual for the SediMeter™ software, version 4.0. It is intended as a 

reference to assist users in getting the most out of the software. It is, however, not 

exhaustive, as the application inherits many features and shortcuts from its development 

platform (LabView) that are not documented here. Right-clicking on different parts of the 

user interface brings up context sensitive menus that provide a wealth of options that are 

beyond the scope of this manual to document. 

Document Version 

Present version rev. 4.0, 2018-01-06. 

Software Scope 

SediMeter.exe ver. 4.0 is the communication and data management application for 

SediMeter™ SM3 instruments having firmware revision 2, as well as for SM4 instruments. 

SediMeter.exe 3.7 is the last version that supports SM3 firmware revision 1. 

Supported Operating Systems 

The application has been developed and tested under Windows 10. 

Installation 

Insert the memory stick or CD and follow the instructions. Do not change the default 

directories, as it may prevent the software from working properly. You will get warnings that 

the software has not being certified; this is normal (it would be cost prohibitive to certify the 

software, since every time an update or customization was made it would have to be re-

certified).  

Drivers 

The communication with the SediMeter™ instrument is through a USB to RS-485 adapter. 

Download and install the driver from http://www.ftdichip.com/Drivers/VCP.htm  

Copyright 

This manual, as well as the application it refers to, is ©Lindorm, Inc., 2006-2018. All rights 

reserved. Contact copyright@lindorm.com to request permission to use the material. 

SediMeter™ is a trademark of Lindorm, Inc. 

Warranty 

This software is supplied for free. No express or implied warranty is made regarding the 

usefulness for a specific purpose, beyond to communicate with Lindorm’s SediMeter™ 

instruments. 

http://www.ftdichip.com/Drivers/VCP.htm
mailto:copyright@lindorm.com
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Please Note 

Window Behavior 

Windows in this application are “modal,” which means that you have to close the last window 

opened to return to the previous window (the control is passed to the last window, so the 

underlying window is non-responsive). Use the File  Close method to close a window; do 

not try to close it using the Windows operating system (the X mark is turned off for that 

reason).  

Turbidity Units 

Throughout the manual and the software, a number of units for turbidity are mentioned. They 

are all variants of FTU and the use of different abbreviations is done in order to distinguish 

between measurement methods, since different methods (light wavelength, and angle of 

measurement in relation to incident light) affects the results.  

Standard units 

FTU = Formazin Turbidity Units, signifies that the instrument has been calibrated using 

Formazin, regardless of measurement method. 

NTU = Nephelometric Turbidity Units, as FTU but measured according to the EPA method, 

i.e., white light scattered at 90º angle.  

FNU = Formazin Nephelometric Units, as FTU but measured according to the ISO 7027 

method of near infrared (NIR) light scattered at 90º angle. The wavelength should be centered 

around 850 nm. 

FBU = Formazin Backscatter Units, as FTU but measured as close to 180º scattered back to 

towards the light source. In the SediMeter this is measured with NIR light centered around 

945 nm. 

Proprietory units 

FNMU = Formazin Nephelometric Mixed Unit, this is a mixture calculated in the software 

from the SediMeter SM3 data by taking the average of the top 6 straight backscatter 

measurements, and the top 6 oblique (nephelometric) measurements, all taken in 945 nm NIR 

light, and combined so that at low FTU only the oblique values are used, at high FTU only 

the straight values, and in between they are smoothly mixed.  

FFU = Formazin Fluorescence Units, this unit is used for measurements where UVA light 

(365 nm) is measured as 90º scattered visible (white) light and calibrated using Formazin. 

The UVA LED emits some visible light above 400 nm, and the photodetector is somewhat 

sensitive to wavelengths shorter than 400 nm, why the FFU value may be larger than zero 

even in the total absence of fluorescence. This value should be evaluated in conjunction with 

the NTU value (which is measured coaxially and using the same photodetector). 
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The Two Essential Windows 

SediMeter Control window 

When starting the application, the SediMeter Control window 

appears. The Connection tab is open, and the other tabs are 

inaccessible until a connection is established as described below. 

Connection tab 

Serial Port pull-down menu 

Select the COM port the SediMeter is 

connected to. Use the Refresh option if you 

connect the cable after the application was 

started. 

Baud Rate 

The default baud rate of the SediMeter after a Reset is 9600. If you 

have set an instrument to another baud rate previously, then you must 

set that baud rate here before connecting. 

Connection Method 

Select USB cable (which is actually an adapter to RS485) or 

SediLink radio, depending on how you have connected the 

SediMeter(s). If you select radio an indicator for successful 

establishment of Telemetry connection will appear. 

Open Connection button 

Click to open the serial port after plugging in the USB connector of 

the cable or the radio. If there is no error the 

remaining tabs get unlocked, and the footer 

of the window becomes un-dimmed.  

Footnote 

Most users can ignore the footer. Only those using real time 

monitoring with more than one instrument need to bother. 

Every message that is transmitted starts with a one-byte address 

code, the NetAddr (aka SediMeter ID, or RS485 ID). A value of 0 

(zero) signifies a broadcast to all connected instruments. A value of 

1 to 255 is used to address a specific SediMeter. 

Use 0 for broadcast commands (e.g., if you want to synchronize 

the time of all connected units). However, to get a reply from an 
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instrument, you must enter that SediMeter’s NetAddr in the Send To field. The Reply From 

field will show which unit replied. 

Timing tab 

As this tab is opened, the software automatically performs a GET operation (similar to the 

user pressing the GET button) and populates the indicators with the values from the 

SediMeter. 

Computer Time indicator 

This indicates the present date and time that the computer 

is set to. 

When you click SET, the software always updates the 

SediMeter clock from the computer clock, so make sure 

your computer clock is set correctly. 

SediMeter Time indicator 

This indicates the date and time in the SediMeter.  

dt (s) indicator 

When the SediMeter clock is read, the difference 

compared to the computer clock is calculated and the 

number of seconds is shown in this indicator. A positive 

value means that the SediMeter is ahead of the computer 

clock.  

You can click the end values (60, -60) and edit them 

using your keyboard to adjust the scale. Click elsewhere 

in the window to effectuate the change.  

Start Time control/indicator 

The start time for self-timed logging in the format hh:mm:ss. The next time that the 

SediMeter clock reaches this time, and it is in Logging Mode, it will start logging. Each time 

a measurement is made, this setting in the SediMeter will be increased by the amount 

specified as the Interval. As an indicator, it always shows the time of the next measurement. 

Interval control/indicator 

The interval between measurements in hh:mm:ss. The minimum value you can set is 1 s. 

However, the software will not allow you to set a shorter value than the Min Interval that it 

calculates (see below). Since in SM4 the burst sampling of accelerometer data is fixed (in the 

calibration), the minimum is typically 2 or 3 seconds. In SM3 you can set it to 1 s but it is 

not recommended, since you will have a very short time window for re-establishing control 

over the instrument (as it does not listen to commands while measuring). 
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Time switch 

Selects whether to display the time as UTC or local time. 

This affects the values in Computer Time, SediMeter 

Time, and Start Time. (Internally in the SediMeter the 

time is always stored as UTC to avoid having to deal with 

time zones or seasonal time changes). 

Burst Interval and Samples controls/indicators 

SM3 instruments 

The number of burst samples to take per measurement, 

and the time interval between them. The interval can be 

from 1 to 16 seconds, and the number of samples can be 

from 1 to 20.  

The samples are taken after the start of the 

measurement, and the measurement does not end until all 

the samples have been taken. During this time, the 

instrument will be not listen to commands.  

SM4 instruments 

These are indicators only since the values are determined by the calibration file. In SM4 these 

refer to accelerometer measurements. These samples are taken before the end of the 

measurement. This is to allow a measurement to be triggered by an accelerometer event, and 

the triggering event to be captured in the data.  

Min interval 

This indicator shows the necessary minimum measurement interval. The software will not 

permit a shorter interval to be used.  

SET button 

Sends the timing values from the controls to the instrument in the Send To field, or to all 

connected instruments if the Send To field equals 0. 

GET button 

Retrieves the settings from the instrument whose NetAddr is selected in the Send To, and 

updates all the indicators. When this tab is opened, a GET command is sent automatically. 
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Mode tab 

The main use of this tab is for turning Logger mode on and off in the 

SediMeter. The settings are grouped in two groups. Mode and baud 

rate are changed in the instrument using the SET button, while the 

instrument’s Net Address is changed using the CHANGE button.  

Mode control/indicator 

SediMeter SM3 and SM4 have two modes, Sleep which is the 

universal mode, and Logger, which is only used for stand-alone self-

timed logging with data stored to the internal memory. 

To start logging, select Logger here and click SET. After you 

switched to Logger mode you can no longer change timing or 

cleaning settings, nor can you empty the 

memory, so all of that you should do first. 

Changing mode is the very last step. 

RS-485 Baud Rate control/indicator 

This refers to the baud rate in the instrument. The default is 9600 

baud (with 8 data bits, 1 stop bit, and no parity). You can change 

this to 115,200 baud. The software will automatically switch to 

115,200 baud as well. However, if the software does not switch you 

will lose communication. If so, return to the Connection tab, 

disconnect, change the baud rate in the software there, and click 

Connect again. 

The higher baud rate allows for faster 

data download, and less current drain when using radios. 

The lower baud rate gives greater range when using radios, and 

allows for longer cables when doing real-time monitoring in a 

physically connected network. 

If you are servicing an instrument used for stand-alone logging 

you will also want to charge the battery. Charging the battery takes 

about as much time as downloading data over 9600 baud, so you 

might as well use the lower baud rate in that case. 

SET button 

Clicking this button sends the values of the mode and baud rate.  

Success indicator 

The Success indicator turns green if the instrument accepted the changes, but it turns red (and 

the mode setting reverts) if the change was not accepted. 
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GET button 

Clicking this retrieves the mode and baud rate setting from the selected SediMeter and 

updates the respective fields. This command is sent automatically when the tab is opened. 

New NetAddr control 

This changes the NetAddr (aka SediMeter ID) in the instrument. Each instrument on an RS-

485 network must have a unique number in the range 1 ≤ NetAddr ≤ 255.  

CHANGE button 

Click to change the NetAddr in a SediMeter. The usage depends on how you are connected, 

as follows. The new NetAddr number remains in the instrument even after a Reset. Only 

change this if you need to have more than one instrument on the same real-time network. 

Method for changing NetAddr (SediMeter ID) in an instrument:  

1. Enter the new value in the New NetAddr field. 

2. Enter the old value in the Send To field. 

3. Click SET. The Reply From field will say 0, since no reply is sent.  

4. Enter the new NetAddr in the Send To field. 

5. Click the GET button, which updates the Reply From field. 

6. Verify that communication works by checking that Reply From equals Send To. 

Cleaning tab 

This tab contains the control for the UV LEDs of SM4, the 

vibrator of SM4 and SM3C, and the mechanical cleaning shuttle 

of SM3B. The usage depends on the type of cleaner on the 

instrument. 

Manually Activate Motor or UV LEDs 

These buttons permits manually running the motor in SM3B, or 

blinking the UV LEDs in SM4. 

UV Blink Interval (seconds) 

In SM4, the UV lights will blink with the interval in seconds 

selected here. They are programmed to not activate when the 

instrument is lying down, only when it is withing 45 degrees from 

vertical (this is to protect the operator’s eyes and not to waste 

battery on land). 

Wiper and Vibrator Settings 

In SM3B, this is the setting for the mechanical wiper, while in SM3C and SM4 it refers to 

the vibrator motor. Wiping Interval is in units of measurements. That is, if set to 2, it will 

activate every second measurement. 0 means no wiping or vibration.  
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The Next Wiping allows specifying an initial period without cleanings. If set to 0, there 

will be no activation; 1 means it will activate at the 1st measurement, and so on. 

Download tab 

This is for downloading data from the instrument, and for erasing the memory. Broadcasts 

are not supported for any action on this tab. 

CHECK button 

Click this to request information from the SediMeter and update 

the associated indicators (unlike in other panes, this command is 

not sent automatically when opening the pane). The following 

indicators are populated by this command: 

Memory Usage indicator 

Blue color indicates new data, whereas red color indicates old 

data (blue = new, red = read). Data may be marked as old in three 

ways: by being downloaded, by being discarded (see below); or 

after an instrument Reset. 

Total Records indicator 

The number of records currently in the internal memory.  

New Records indicator 

The number of records that have been recorded but not yet marked as read. When full, the 

instrument stops recording. 

Size indicator 

The total number of records the memory can hold.  

Free indicator 

The number of records that are still unused.  

Download to File control 

The full path and file name (including extension) for where to 

save data to be downloaded. You may type in the path and 

filename, or simply use the browse button. The default 

extension is *.sm4.  

Enter a path and file before clicking on any of the download 

buttons below this field. 
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Get New button 

Clicking this button downloads the new records from the selected SediMeter to the indicated 

file.  

Get All button 

Clicking this button downloads all records from the selected SediMeter 

to the indicated file. Download starts with the first record, number 0. 

After the download is finished a dialog indicates how many records have 

been downloaded.  

Discard New button 

This marks all records in the SediMeter memory as “read”. Use this button to discard data 

rapidly, without having to download. When all data are “read” then you can erase the memory 

to free up space. 

Erase All button 

This erases all records, freeing up the memory. It can not be executed while there are new 

data in memory. If you don’t want to download the new data, use the Discard New button. 

Real Time tab 

This tab contains a list of the instruments that will be interrogated for data in real time 

monitoring. As the default instrument ID (NetAddr) is 1, the default SediMeter list contains 

a single record with NetAddr 1, for convenience. However, if you change the instrument 

NetAddr or add additional instruments with other IDs, then you must edit this setting. The 

setting is stored as a separate file, and can also be edited in the Edit menu (see below) so that 

you don’t have to redo it every time you open the application. 

You can also press the Roll Call button to automatically populate the records with the 

NetAddr list. 

The location of the instruments is optional to enter. If entered, they permit you to see a 

map of the instruments (it is available as a menu item in the Data View window).  
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Interval 

This is the measurement interval that will be used. In the case of 

SM3 instruments that have burst samples larger than one, the 

actual interval that will be used is the largest of this value, and 

the minimum time it takes to make one measurement plus one 

second.  

Save to File control 

Select path and file for where to store the data collected during 

real time monitoring. Click on the Browse button, or type in the 

path and file name. If no file is specified, the Real Time 

Monitoring will not save the data to file; however, you can 

specify a file and start saving also after initiating the monitoring, 

in the Data View window (see below). 

Menus 

File menu 

Open…  Ctrl+O 

This is the file open command. You can open SediMeter files 

with extensions *.sm4, *.sm3, and *.sm2, albeit data from the 

optional analogue sensors in the older files are not treated 

correctly. Use version 3.7 or older for those older files. 

Exit  Ctrl+Q 

Quits the application. 

Edit menu 

Cut  Ctrl+X 

Removes the selected text from a field and places it in the 

clipboard. 

Copy  Ctrl+C 

Creates a copy of the selected text in the clipboard. 

Paste  Ctrl+V 

Creates a copy of the text in the clipboard in the selected field at the place of the insertion 

cursor. 
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Raw Data… 

Opens the File view window (see below) with the data presently in memory. If there are no 

data in memory, it opens as untitled.sm4. 

SediMeter List…  

Opens the SediMeter List window, for editing the list of 

connected instruments (see below). 

Radio Network… 

Opens a window for changing settings in the radio in connected 

SediLink radio modems. The radios are XBee radios from Digi, 

and for commands refer to their documentation. If Telemetry is 

not connected (i.e., you are using a cable and not radio) then this 

dialog will serve no purpose.  

Turbidity Offset 

Opens the Turbidity Offset window (see below). Allows for 

recalibration of the turbidimeter offset without changing the slope. This can be done by the 

operator and even in the field if a suitable tank is available (known FTU, sufficiently large, 

darkness). 

Advanced > Recalibrate Instrument… 

Opens the Recalibrate Instrument window. The Recalibrate window is password protected, 

allowing for access being limited to only authorized personnel. 

Advanced > Monitor Communication Port… 

The window that opens (see below) is intended for debugging an RS-485 network between 

some other master, and one or more SediMeters. The software passively displays the data on 

the communication port. 

Data menu 

Analyze Logged…  Ctrl+A 

Opens the SediMeter Data window (see below) in post-processing mode. This menu item is 

disabled until some data have been opened, either through download from an instrument or 

by opening a file. 
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Monitor Real Time…  Ctrl+M 

Opens the SediMeter Data window (see below) in real-time monitoring mode. In the case of 

SM3, the burst rate and number of samples are taken from the respective fields in the Timing 

tab, but the measurement interval comes from the Real Time tab. 

Measurements start immediately, and are timed by the computer, 

but the time recorded in the file is the time of the SediMeter 

clock. This menu item is unavailable until a connection has been 

established in the Connect tab. 

Web Server 

This item, which is disabled in version 4.0, turns on and off the 

web server on the default port. A checkmark indicates when it is 

on. Do not turn it on if another application on the computer is 

running a web server (or any other process) on that port. 

When on, the web server presents the SediMeter Data 

window as an image, automatically updated every 60 seconds. 

The page can be viewed from any web browser by entering the 

domain or IP of the computer in the browser address field. For 

instance, if the IP is 192.168.1.100, type http://192.168.1.100 to view the web page. 

The actual document is C:\Lindorm\SediMeter\www\SediMeter.html (provided that C: is 

the Windows volume). You can edit that document in a text editor to put in your custom 

information before and after the SediMeter Data window. 

Window menu 

The content of this menu is a list of the currently open windows of the application. Do not 

use this menu to switch between windows. You must instead close the last opened window 

from its File menu in order to return to the previous window.  

Help menu 

Show Tip Strips  Ctrl+T 

Turns off or back on the tip strips that appear when you idle the mouse above a control or 

indicator.  

Show Context Help  Ctrl+H 

Turns on or back off a context-sensitive help window. It displays more in depth help about 

the items you idle over with the mouse, than the tip strips provide.  

About… 

Shows the About window. Click anywhere in it to close it. 

http://192.168.1.100/
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SediMeter Data window 

This window is the main human 

interface for the data. The same 

window is used for presenting pre-

recorded data and for real time 

monitoring. 

SediMeter NetAddr control 

Most users can ignore this control.  

When doing real time monitoring 

of a network, or when analyzing such 

a file in post-processing, this control is 

used to switch between viewing the 

data from different instruments. 

Graphs 

The window is dominated by an intensity chart and a data plot graph. They have the same X-

axis time scale to be comparable. They also share many features, which will be presented 

below in the section Graph controls.  

SediMeter Sensor Chart 

This graph shows the SediMeter data with time on the X-axis, turbidity detector on the Y-

axis, and signal level as color. The color scale is indicated on the Z-scale ramp to the right of 

the graph itself. 

 
The color scale is editable. Move the mouse over a scale marker. When the cursor changes 

to a double arrow you can drag the scale marker up or down. You can also right-click it and 

change its color. If you drag from the end markers you get new intermediate points.  

In the top margin of the window the number of samples is shown. In real time monitoring, 

the date and time appears to the left of Samples. 
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Redraw, Reset, Adjust buttons 

Redraw simply redraws everything. Reset changes the color scale of the Z-scale ramp to the 

default and redraws. Adjust changes the color scale to the range present in the straight 

backscatter data and redraws.  

Turbidity radio buttons 

Select whether to display only the straight backscatter (36 values), only the oblique scatter 

(35 values), or both (71 values). 

Data Plot  

This graph plots the measurement data with one value per measurement. The parameters are 

listed in the legend to the right. Each parameter can be turned on and off in the plot, its color 

and type changed, and the Y-axis on which it is plotted can also be changed. 

As default, Level, Temperature, Battery are plotted on the left scale, which is fixed as 0 

to 36. Turbidity and other values are plotted on the right scale, which automatically scales to 

the values at hand. The autoscale feature can be turned on and off by the user.  

 
Note that the level is calculated both in the instrument firmware and in this software. The 

software is by default automatic but can be changed to interactive mode (see Adjustments 

tab). 

Graph controls 

A number of controls are common for the two graphs in the data window. They are explained 

here. 

Graph cursor 

One cursor is defined for each graph in a light yellow field (the cursors are named “A”). To 

the right of the cursor name and icon there are columns for the cursor’s current X position, 

Y position, and in the case of the intensity graph, the Z value at that point. 

If the cursor is not visible in the graph, right-click the cursor (+) in the cursor control and 

select “Bring to Center”. To be able to drag the cursor in the chart, make sure the cursor 

symbol (+) is selected in the Graph Palette (see below). You can also move the cursor by 

clicking on the diamond-shaped controls to the right of the cursor control. 

The cursor for the line graph will snap to a line. Right-click on the cursor in the cursor 

control to bring up the context-sensitive menu and select which line to snap to. 
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Graph Palette 

In the top or bottom right corner of each graph there is a palette with three choices; cursor, 

magnifying glass, and a hand for dragging. The magnifying choices are, from left to right on 

the first line: Zoom in in both dimensions, zoom in in the X dimension, zoom in in the Y 

dimension. On the second line: Fit all data to the graph, zoom in to the point of clicking, 

zoom out around the point of clicking. 

Changing X and Y axis scales 

The X-axes all have auto scale as default. To be able to zoom in in the X dimension, you 

must first turn off auto scaling. Right-click on the graph or on the X-axis to bring up a menu 

where you can turn off “AutoScale X.”  

The intensity graph has manual scaling on the Y-axis, from 0 to 36. If you change the 

scale and want to restore it, simply click the green bar to the left.  

The Data Plot has double Y-axes. To turn AutoScale on or off on either one of them you 

must right-click on one of the scale values of the scale in question.  

Other features 

You can change the legend color, line type etc., and edit the names in the legend. 

The intensity graph can be exported as an image by using the Copy Data command in the 

context-sensitive menu. The exported image includes all items that presently are visible. You 

may wish to turn off the Graph Palette and the Cursor Legend prior to copying the image. 

You do that by bringing up the context-sensitive menu (right-click) and de-select them under 

Visible Items. 

The other graphs can be exported as a simplified image (better for including in a report) 

in a similar way. 

Each graph also has a Scale Legend, although it is off as default. The scale legend 

provides a graphical user interface for setting AutoScale, to scale-to-data once, and for 

accessing menus for changing a number of settings of the graphs. To turn it on, right-click 

the graph and select Visible Items -> Scale Legend. 

The line graphs have an Annotation feature. Right-click on a line to bring up a context-

sensitive menu with Create Annotation as one choice. After you have created it you can 

change its color and other attributes. This may be used for marking in the graph when certain 

things happened, such as taking a calibration reading with another method. 

Data Plot tab 

This is a table of the same data as in the Data Plot. The column labels for turbidity are 

different in SM3 and SM4, and SM3 does not populate any column after Battery voltage. 
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You can save the contents of this table at any time as a tab-delimited text file by clicking 

the SAVE button. 

Burst Samples tab 

In the case of SM4, this graph contains the accelerometer data in 3D from one measurement 

at a time. Select which one to see by using the Sample control. 

 
In the case of SM3, this tab contains burst samples provided that the number of Samples 

is larger than 1. If Samples is set to 1, this plot remains empty. The data shown will be Level 

from the instrument firmware, and FBU turbidity from OBS #37. 

Monitoring tab 

The monitoring tab, along with the two following, is relevant only for real time monitoring. 

 

Log File control 

The Log File path control field gets its initial value from the Save to File field under the 

Monitoring tab in the SediMeter Control window. It is also possible to change the value in 

this window, either by writing or using the browse button.  

Log to File checkbox 

A combined control and indicator for saving real time monitoring data to file. 

Monitoring checkbox 

A combined control and indicator for real time monitoring. To turn monitoring on or off, use 

either this checkmark or the Monitoring menu. 

Measuring indicator 

This is green during a measurement, and grey in between, in real time monitoring.  
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Telemetry indicator 

This is green when telemetry is on (communication via SediLink radio modem). 

Timing Error indicator 

This is a warning for timing errors. It is only visible during real time monitoring. 

Telemetry Error indicator 

This is a warning for telemetry errors. It is only visible during real time monitoring. 

Waiting, Offset, Measurement Interval, New Interval, Last Measurement 

These aids for debugging telemetry are only visible during real time monitoring. 

Error message 

Any “soft” errors during real time measurements are displayed here. Soft errors are those that 

the software can ignore and continue anyway. 

Network Real-Time Data tab 

This tab shows the last measurement from each connected instrument in a real-time 

monitoring network. Whereas the Data Plot tab shows all the data from the one instrument, 

this tab shows one measurement from all the instruments. 

 
It calculates the change in elevation from a reference level, and displays it as either 

accumulation or erosion (see illustration). Select with the switch whether to use the values 

from the instrument firmware, or the ones calculated in software (when using software 

values, the displayed accumulation and erosion values reflect the previous measurement). 

Click the Reset Reference Levels button to use the value from the first record in memory as 

reference, or edit the reference levels manually in the table. 

When using SM4, the 4th column will display the FNU value from the ISO style 

nephelometric turbidimeter, and the 5th column will display the NTU value from the EPA 

style nephelometric turbidimeter. When using SM3, the 4th column will display the FBU 
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value from OBS #37, and the 5th column the FNMU value calculated as a composite of the 6 

topmost straight and 6 topmost oblique FTU values from OBS array. 

Alarms tab 

This tab is for defining alarm conditions and what to do in case they are triggered.  

The Alarm Thresholds refer to the accumulation and erosion values from the Network 

Real-Time Data tab (see above). The switch for Turbidity selects which turbidity value to 

use; from the 4th or from the 5th column in the Network Real Time Data table. 

 
When any instrument in the network exceeds the set threshold, the corresponding alarm 

light goes red. If the Audible Alarm checkbox is ticked, the computer will also beep for each 

measurement when an alarm is triggered. 

If the Send Email on Alarm checkbox is ticked (and the relevant fields filled in) an email 

will be sent the first time any instrument triggers an alarm. The email will say which alarm 

was triggered, and by which instrument. To avoid having an email sent too often, a minimum 

interval between emails can be specified. Contact your network administrator if you need 

help with the server settings. 

Adjustments tab 

The left part of the tab offsets the FBU values in the SediMeter Sensor Chart by compensating 

for the reflections and signal loss in the holder tube, mostly for esthetic reasons. It is better 

to use a turbidimeter located above the holder tube for turbidity measurements. 

The right part of the tab contains settings for estimating the level, and changes how “Level 

{software} (cm)” is calculated. The default is automatic bottom detection but you can set this 

to manual and enter the turbidity value you chose as the definition of bottom in the Bottom 

Definition control. The software will start looking from lower to higher and the first time it 

encounters an OBS with less turbidity value than the threshold, it will assume that to be the 

bottom. 

In many cases there are complications such as anoxic black sediment below the surface 

with very low reflectivity (in the example below, such a dark layer developed during the 

deployment), or dirt on the sensor that gives a high turbidity reading up in the water. Using 
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the settings for “Bottom is lower than … but higher than …” it is possible to constrain the 

software to the interval where the user knows the bottom to be. In the example above, the 

bottom (black line) was constrained to between 12 and 22 cm, based on a visual inspection 

of the intensity chart. Of course, initially the level was below 12 cm, but in that period the 

instrument had no problem finding the bottom without help (red line).  

It is also possible to ignore a single OBS detector, replacing its value with the interpolated 

values from the detectors above and below it. To do so, check the mark and enter the number.  

The two graphs illustrate how the software level can be obtained by forcing the program 

to look only above the anoxic and dark bottom layer (the vertical spikes in the bottom were 

made by sea urchins; they liked to congregate at the base of the sensor, and are thought of 

being responsible for the periodic cleaning of the sensor from algae).  

Color Plot tab 

The false color plot is created by combining the straight and oblique scatter turbidity into a 

single image with 5 mm vertical resolution, where yellow represents straight backscatter and 

blue represents oblique scatter. Due to the total reflection against air, an exposed sensor will 

create a blue image. This color plot is therefore an easy visual aid for those who deploy the 

instruments in the intertidal zone.  

 
You can zoom in and out. When zooming out the vertical scale is automatically doubled. 

You can also change the luminosity, and make the color scale logarithmic. 
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Menus 

File menu 

Export Data from this SediMeter… 

This item exports the data from the selected instrument as a tab-delimited file. The columns 

vary depending on instrument version. This is an example from SM4 (most of the repeated 

columns with OBS and accelerometer data have been hidden). 

 

Close…  Ctrl+W 

Closes the window. This item is not active during an ongoing monitoring. First stop the 

monitoring (in the Monitoring menu).  

Edit menu 

Cut, copy, and Paste work as previously described. 

Monitoring menu 

This menu has one item. It reads Off and is dimmed in post-processing mode. It reads On 

and is active and selected in real time monitoring mode. 

On/Off 

To turn off monitoring, de-select this item. Note that the application carries out one more 

measurement before it stops. Turning this on or off is equivalent to checking or unchecking 

the checkmark in the Monitoring tab. 

When you turn off monitoring the File -> Close item becomes operable.  

View menu 

3D View… 

Opens the 3D display window.  

Network Map… 

This opens the Map of SediMeters window. 

Window menu 

The content is as previously described. 
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Help menu 

The content is as previously described. 
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Other Windows 

File window 

This window shows the raw data files type *.sm4 (it can also open files from with extension 

*.sm2 and *.sm3). To open it, select Raw Data… from the Edit 

menu in the Control window. 

Front panel objects 

An *.sm4 file may contain data from a single instrument, or from 

a network of up to 255 SediMeters. For each instrument there is 

one record per measurement. This creates a 2D matrix of 

measurements, which occupies the main portion of the front panel. 

The right-hand side of the window represents a single record. 

Record selector 

Use this to step through the records from one and the same 

instrument. To find the last record, right-click in the white field to 

open a context-sensitive menu and select “Show Last Element”.  

Instrument selector 

Use this to step through synchronous records from different instruments (such as created by 

a real-time monitoring network). 

Cluster indicator 

Each record is a cluster of various elements. This is an indicator, meaning that the data are 

not editable. The only possible edit in this window is to remove records from both ends (see 

below). This is by design, so as to preserve data integrity. 

 You don’t need to know what these values mean. They are translated to human-readable 

form in the Data View window. If you still want to see what each thing represents, either turn 

on tip strips (Ctrl-T) or help (Ctrl-H) and hover over each field. 

Records 

The total number of records per instrument. 

Volt meter 

This indicates the minimum voltage in all the records. If the voltage falls close to 3.2 V the 

SediMeter will turn off monitoring. If so, you may not have data from the entire deployment 

period.  
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Status 

This indicator is currently not used. 

LogData Path 

The full path and filename of the present data. 

Menus 

File menu 

Open…  Ctrl+O 

Use this to open a previously created *.sm4 file. 

Merge…  Ctrl+M 

Not presently supported, the purpose is to join files from different 

instruments recorded with the same timing settings. 

Save  Ctrl+S 

Saves the current data to the same file as last time. Use this to 

save the data after deleting records since the edits are not 

automatically committed to file. 

Save As…  

Opens a browser dialog for picking a new path and file where to save the current data. 

Import MMC Log File… 

Use this for importing data from the SD or MMC card of a LogDator logger. Not presently 

supported. 

Export Text File… 

This item is mainly provided for development and debugging purposes. A more user-friendly 

export method is provided in the Data View window (see above).  

This method exports the SediMeter data table as a tab-delimited ASCII file (in decimal, 

not hexadecimal, number format). Column one is the FTU value of the straight backscatter 

data at levels 0 cm, 1 cm, etc. Column two is the FTU value of oblique backscatter at levels 

0.5 cm, 1.5 cm, etc. Row one is OBS #1, row 36 is OBS #36, of the first measurement of the 

first SediMeter. If there are more than one instruments in the *.sm4 file, the first 

measurements of all the instruments are first output, followed by the second measurements 

of all the instruments. 

Close Ctrl+W 

Closes the window (while keeping the data in memory). 
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Edit menu 

Cut, Copy, and Paste function as previously described. 

Delete submenu 

These commands permit removing records in either end of the 

monitoring period. It is useful if you have data recorded before 

deployment or after retrieval. To commit any change to disk, you 

must select Save or Save As after the deletion. 

First Record  Ctrl+F 

Deletes the first record (with index 0). 

Last Record  Ctrl+L 

Deletes the last record (with index [Records – 1]). 

All Preceding 

Deletes all records before the one currently showing. 

All Following 

Deletes all records after the one currently showing. 

Window menu 

The Window menu functions as previously described. 

Help menu 

The Help menu functions as previously described. 

Turbidity Offset window 

This window allows for adjusting the offset of the 

turbidimeters, both in the SediMeter array, and in 

the #37 OBS of SM3, as well as the ISO and EPA 

turbidimeters of SM4.  

You will need a calibration tank with a liquid 

of known turbidity, such as pure, filtered, and de-

gassed water. The tank needs to have at least 20 

cm of water in front of the backscatter detectors 

and ambient NIR light must be kept out. A 

suitably sized tank is a 50-gallon black garbage 

bin (round, for strength), or a bathtub lined with 

black garbage bags (with the instrument suspended horizontally near the surface, sensors 

facing down). The black color is an additional protection against reflection. 
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Important Notice 

You must close this window by clicking either Discard or Accept. If you close the window 

or the application by any other means, the instrument will be left uncalibrated. Therefore, 

you should finish this operation as soon as possible, for the sake of safety. 

Instructions 

To zero the OBS array of the SediMeter sensor, as well as the ISO turbidimeter of the SM4, 

turn on Zero SediMeter. To zero the #37 turbidimeter of SM3, or the EPA turbidimeter of 

SM4, turn on Zero Turbidimeter.  

Known FTU 

Enter the FTU value of the liquid in the tank. It is 0 for pure water. Depending on your 

standard operating procedures you may want to enter a small positive value to create a 

deliberate bias. Let us say that there is ±2 FTU in noise. Negative values get reported as 0, 

which means that you cannot calculate a meaningful average when the real value is 0 since 

half the measurements have been truncated to 0. If you instead introduce a +3 FTU bias, so 

that 0 is reported as 3, and you get values from 1 to 5 with the normal noise, then you will 

know from the data that there was no truncating and you can calculate a true average. 

Number of Measurements 

Enter the number of measurements you wish to include in the average. Each measurement 

takes a few seconds. 

Click Measure to start measuring. When the green light turns on it is ready and you can 

inspect the values. Notice that the offset is not in FTU units but in raw bits, which is a 

numerical value about 2 to 10 times larger than the FTU offset value, depending on the 

scaling of each sensor. 

Discard or Accept 

Finish by either discarding or accepting the new values. YOU MUST DO ONE OF THE 

TWO. 

SediMeter List window 

When the application is started it reads the contents of the file 

C:\Lindorm\SediMeter\SM_Network.smnt. The contents of that file can be inspected and 

edited in this window, although it is also available in the Real Time tab of the Control 

window. 

The *.smnt file contains a definition of the SediMeter network, for the purpose of real 

time monitoring. The SediMeters listed here will be polled during monitoring. If one of them 

is not on the network a time-out error will result. If a SediMeter on the network is not listed 

here, it will not get polled. 
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Front panel objects 

SediMeter List 

This is a one-dimensional table that you can navigate through using 

the horizontal scroll bar. In the right-most position, you see the next 

unused position, where you can make a new entry. 

NetAddr 

The NetAddr of a SediMeter on the network. 

East/Long (optional) 

The easting or longitude of this SediMeter. 

North/Lat (optional)  

The northing or latitude of this SediMeter. 

Units 

The units for East/Long and North/Lat. The options are degrees and meters. 

Datum & Projection 

A free text description of the projection parameters associated with East/Long and North/Lat. 

GET button 

Reads the NetList in an attached LogDator logger and updates the SediMeter List 

accordingly. The coordinates are not affected. 

SET button 

Writes the NetList to an attached LogDator logger based on the NetAddr values in the 

SediMeter List. The coordinates are not copied. 

ROLL CALL button 

This button queries each of the possible 255 NetAddr values, and updates the SediMeter List. 

If a SediMeter in the list does not respond, it is removed; if one responds that was not in the 

list, it is added to it; and finally, the list is sorted in NetAddr order. Newly added NetAddr 

entries get coordinates (0,0). 

You can use this feature to automatically edit the list, and to verify that all units 

communicate. 
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Menus 

File menu 

Open…  Ctrl+O 

Opens a *.smnt file that you choose. Use this and the Save Copy As… commands to maintain 

records of different networks on the same computer. 

Save  Ctrl+S 

Saves the data to the file C:\Lindorm\SediMeter\SM_Network.smnt (provided C: is the 

Windows startup volume). 

Save Copy As… 

Saves a copy of the data to a file and path you select. 

Close  Ctrl+W 

Closes the window (but leaves the data in memory). 

Edit menu 

Cut, Copy, and Paste work as previously described. 

Delete All 

Deletes all entries in the SediMeter List (but leaves Units and Datum intact). 

Window menu 

As previously described. 

Help menu  

As previously described. 

3D display window 

This window contains an Active X control showing a 3D view of the SediMeter straight 

backscatter data.  

Dragging with the mouse changes the point of view. Dragging with the Alt key depressed 

zooms in and out. Dragging with the Shift key depressed pans the image.  
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Map of SediMeters window 

This window contains a single object, a map showing the relative 

position of the SediMeters in the network. The positions are those 

entered in the SediMeter List window (if no coordinates are entered, 

the map will be empty as in this example). 

Radio Click OK to close. 

 

Radio Network window  

This window allows the settings in the SediLink 

radios to be changed from the SediMeter 

application. Refer to the SediLink documentation 

for settings.  

Sleep period and wake time affects the 

communication and also the blinking rate of the 

white LEDs in the SediLink. 

The bottom half of the window allows generic 

commands to be sent and settings to be queried. 

The button Enter API Mode and the indicator 

above it are used to enable API communication. 

When done, click OK. Note that if no radio is 

present, an error will result. 
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Monitor Communication Port window 

The purpose of this window is 

to monitor the traffic on an RS-

485 network. It can be used for 

debugging when setting up 

communication between a 

third-party logger and the 

SediMeter (note that it can not 

be used to monitor the 

communication between the 

same instance of 

SediMeter.exe and a 

SediMeter instrument). The 

traffic is displayed in 

hexadecimal code to the left, 

and as ASCII characters to the 

right.  

The first 4 bytes are the 

message header. In the center 

these 4 bytes are decoded, 

although the checksum is 

analyzed so a value of 00 indicates a valid checksum. The indicator turns green for valid, and 

red for invalid checksum. 

The window can operate in two modes, continuous and one shot. In continuous mode, it 

replaces the content as soon as a new message is received. In one-shot mode, it displays the 

latest message until it is rearmed. When the rectangle is green and reads Listening it is waiting 

for new traffic.  

When the rectangle is red and reads Rearm it is keeping the last message displayed. It is 

still receiving messages in the background, queuing them until the rearm button is pressed. 

One can thus step through the messages one by one. 

Recalibrate 

Since the recalibration functions are password protected in order to be accessible only by 

qualified and trained personnel, they are left out of this user manual on purpose. 
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